




















































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































Appendix 

Introduction to 
itesources 

If you're new to Macintosh programming, you're probably new to the 
idea of resources as well. Almost every Macintosh program makes use of 
resources-code that defines the look of user interface items like menus 
and windows, yet is easily editable in a visual manner. If you've never 
programmed, look over Appendix A and Appendix B to get overviews of 
the C and C++ languages. Then move on to Appendix C for a brief 
overview of what Macintosh programming is all about. Finally, return to 
this appendix for a little extra information on resources. 
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For a complete reference on Macintosh programming using C or 
C++, consider either Macintosh Programming Techniques, Second 
Edition, also by M&T Books, or some of the books that are a part 
of the Inside Macintosh series. 

Resources and the GOI 
When you look at your Macintosh screen, everything you see originat­
ed as a resource: 

• A menu bar has an MBAR resource that specifies which individ­
ual menus are in it. 

• Each individual menu has its own MENU resource that defines 
the items in that menu. 

• A window has a WI ND resource that defines its size and initial 
position on the screen. 

• A dialog box has a D LOG resource that defines its size and ini­
tial position. 

• A dialog box has a second resource, the DI TL, that defines the 
items, such as buttons, that are to appear in the dialog box. 

There are about 100 different resource types. You'll probably only find 
the need to use fewer than a dozen types in your programs. Here's a list 
of some of the more commonly used resource types. 

ALRT Defines the look of an alert box 
B ND L Relates an icon to a program 
CODE All the instructions of a program 
DI TL Contents of a dialog box 
DLOG Defines the look of a dialog box 
DRVR Desk accessory-a driver 
IC N// List of icons 
PI CT Picture 
SI Z E Partition size of a program 
STR// List of strings 
WI ND Defines the look of a window 
snd Sound 
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Resources and Source Code 
Appendix C mentioned that there is a relationship between a resource 
and source code. A resource holds the data that defines the look of an 
interface element of a program-such as the size, initial screen place­
ment, and look of a window. Source code then allows a program to 
make use of this resource by loading its data into memory. 

A specific example will go far to illustrate the connection between a 
resource and source code. To define the look of a resource, you can cre­
ate a WIND resource using a resource editor. Figure D.1 shows such a 
resource as it is being edited in Apple's resource editor ResEdit. 

J :J WI NO ID 128 from M_y_Resources.rsrc 

s File Edit Resource Window 

~New Window -

Top: EJ Height: ~ 

Left:~ Width:~ 

Color: ®Default 
QCustom 

[8J Initially uisible 

[8J Close boH 

Figure D.1 A WIND resource being edited in the window editor of ResEdit. 

After creating, editing, and saving the resource to a resource file, it's on 
to the source code. At the appropriate place in your program's source 
code listing (typically in response to a user's selection of the New item 
from the File menu), you'll make a call to GetNewWi ndow( ). This 
Toolbox function returns to your program a pointer to the area in mem-
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ory that holds this data. Such a returned value has a data type of its 
own-the Wi ndowPtr data type: 

WindowPtr theWindow; 

theWindow = GetNewWindowC 128, nil, CWindowPtr)-lL ); 

The GetNewWi ndow() function loads into memory the data that makes 
up a WIND resource. Because a resource file may hold more than one 
resource of a resource type, the call to GetNewWi ndow() must specify 
which resource is to be loaded into memory. The first parameter is used 
for this purpose-here you pass the ID of the WI ND resource to use. You 
can look back at the title bar of the ResEdit window editor pictured in 
Figure D.1 to see that the ID of the WIND resource I created has an ID of 
128-the same value I passed to GetNewWi ndow( ). 

The second parameter to GetNewWi ndow() specifies where in memo­
ry the WIND resource data should be loaded. Using a nil pointer here tells 
the Mac to use whatever available memory it wants. This parameter can 
instead be used to place the data in a particular memory location. 

The last parameter to GetNewWi ndow() specifies whether the new 
window should open in front of or behind all other open windows. In 
general, you'll open a new window in front of all others. A value of -1 
accomplishes this. Also, this value must be a pointer, so by convention 
we make it -1 L. And, more particularly, this value must be a special 
type of pointer-a window pointer. Preceding the value with 
( Wi ndowPt r) casts the value -1 L to a Wi ndowPtr type. 

~ 
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A pointer always occupies 4 bytes of memory, as does the long 
data type. By appending an "L" to a number, you force the compil­
er to look at the number as a long, and to reserve 4 bytes of mem­
ory for that number. Casting a value temporarily turns that value 
into one of a different data type. So appending an "L" to the num­
ber 1 causes the compiler to use 4 bytes of memory to hold this 
number, while casting the number 1 to a Wi ndowPtr causes the 
compiler to view the number as a pointer to a window. If that all 
seems somewhat confusing, don't become too alarmed. You'll 
almost always make a call to GetNewWi ndow() as shown. While 
you might use a different WIND resource ID for the first parameter, 
you won't have to modify the second or third parameter. 
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When you create a WIND resource in ResEdit, you have the option of 
specifying whether the window should be visible or hidden when this 
call is made. If you examine the WIND resource in Figure D.1, you'll see 
that the checkbox labeled Initially visible is checked. That means that 
when the call to GetNewWi ndow() is made and the call is complete, a 
window will appear on the screen. If the Initially visible checkbox 
hadn't been checked, that information would have been a part of the 
WIND resource data. In such a case GetNewWi ndow() would still load the 
WIND resource data into memory, but it wouldn't display the window 
on screen. To do that, your source code would make a call to another 
Toolbox function-ShowWi ndow( ). 
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<Ising itesorcerer fis 
Your itesource Editor 

When you double-click on the name of a resource file in a project win­
dow, CodeWarrior launches the resource editor ResEdit and then opens 
the resource file from within that editor. If you use Resorcerer by 
Mathemaesthetics, you'll want to set up CodeWarrior such that it 
launches this resource editor rather than ResEdit. 

In order to start up the proper program, CodeWarrior examines the 
file type of the file name you've double-clicked on. When you create a 
new project using one of the Basic Toolbox project stationeries, the 
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SillyBalls.rsrc file is included. Metrowerks has created this file using 
Apple's ResEdit, so double-clicking on this file name in a project win­
dow will result in CodeWarrior attempting to run ResEdit. If your pref­
erence in resource editors is the more sophisticated Resorcerer by 
Mathemaesthetics, you'll need to change the file type of the resource 
files that Code Warrior uses when it creates a new project. 

First, launch Resorcerer. Do this by double-clicking on the icon of 
your Resorcerer application-don't try to launch it from a project file 
just yet. The Open File dialog box will appear. Use the pop-up menu at 
the top of this dialog box to work your way into the folder that holds 
the SillyBalls.rsrc file used by the Basic Toolbox PPC project stationery. 
Figure E.1 shows the path to traverse to get to this file. 

Choose a file of resources you wish to edit: 

5l Basic ToolboH PPC 

ID Basic Tll 5l C/C++ 

I SillyBal 5l MacOS 

11llJllJi1: 5l (Project Stationery) 
,,'>;,.,,~""-· ,,,G·,;'i.'·. 

5l Metrowerks CodeWarrior 
5lCW10 Gold 
=Hard Driue 
Iii Desktop 

fil 

=Hard Driue 

[ Eject ) 

( Desktop ) 
.............................................. 

n Open )J 

( New ) 

( cancel ) 

Show all files ..,. I I Resolue aliases ..,. I I Set fauorit ... ...,., 

Figure E.1 Moving to the folder that holds the SillyBa//s.rsrc resource file. 

Here you're going to make a change to the SillyBalls.rsrc file that 
is used by the Basic Toolbox PPC project stationery. If you have a 
new project started, note that you're not working with that ver­
sion of the file. 

With the SillyBalls.rsrc file open, choose File Info from the File menu. 
In the lower left of the file's window you'll see two edit boxes. Change 
the contents of the Type edit box from rsrc to RSRC. Next, change the 
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contents of the Creator edit box from RSED to Doug. These changes are 
shown in Figure E.2. Now choose Save from the File menu to save the 
file, then click on the SillyBalls.rsrc window to close the file. 

Types: 

<DF> 

Sil!.Y_Balls.rsrc 
O lndiYidual Resources: i Res. Fork: 286 

i1£ ..----------------....,....,{} ! ~.~.~~ .. ~~~~.: ... ~ ...................... . 
t-=-1 i I Finder Flags ,... I 

11 Map Flags ,... I 
I Label I None ,... I 

;I 
Select Rll ) ( Reuerse ~~nopenlJI 
Changed J ( None ~[New)! 

Type: lnsRC 
Creator: I Doug 

I Created: 14/20/95 1 0:27:38 RM 

I Modified: 19/3/96 3:39:34 PM 

[21 File Busy 
D File Locked 
D File Protect 

Figure E.2 Changing the Type and Creator strings 
in the SillyBalls.rsrc resource file. 

By making this change, every time you create a new project based on 
the Basic Toolbox PPC project stationery, the copy of SillyBalls.rsrc that 
ends up in the new project will be a Resorcerer file rather than a ResEdit 
file. What if you create a project using the Basic Toolbox 68k project sta­
tionery, you ask? That stationery uses a different version of the 
SillyBalls.rsrc file, so you'll need to change the type and creator of that 
version as well. 

From within Resorcerer, select Open File from the File menu. Back 
your way out of the Basic Toolbox PPC folder into the CIC++ folder, 
then move into the Basic Toolbox 68k folder-the folder that holds the 
SillyBalls.rsrc file for the Basic Toolbox 68k stationary. Starting from the 
main Code Warrior folder on your hard drive, here's the complete path 
to this version of the SillyBalls.rsrc file: 
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Metrowerks CodeWarrior:CProject Stationery):MacOS:C/C++:Basic Toolbox 
68k 

Make the same changes to this file as you did for the other version of 
SillyBalls.rsrc, then save and close the file. 

Since I'm supplying you with this tip after you may already have 
created a new project, it's too late for the change to be applied to the 
SillyBalls.rsrc resource file that is a part of that project. However, every 
subsequent project you create using either the Basic Toolbox PPC or the 
Basic Toolbox 68k project stationery will now include a Resorcerer ver­
sion of SillyBalls.rsrc-with no extra effort on your part. Now, you'll 
be able to launch Resorcerer and open a resource file from within a 
Code Warrior project. 

(lJ 
n 0 T E 

If you did in fact jump to this appendix after creating a new pro­
ject, you can change the file type of the project's resource file just 
as you did for the two SillyBalls.rsrc files. Simply open the file, 
change the type and creator, and then save the file. You can then 
test out CodeWarrior's ability to launch Resorcerer by quitting 
Resorcerer, returning to the CodeWarrior IDE, and double-click­
ing on the SillyBalls.rsrc file name in the project window. Now, 
Resorcerer rather than ResEdit should launch. 



Appendix 

Mcmd itesources and 
itesource Editors 

PowerPlant uses a few resource types that aren't common to other Mac 
applications. As you read in Chapter 7, the Mcmd is one of them. To make 
editing resources of these new types easier, use Constructor-Metrowerks 
own Power Plant resource editor. If for some reason you'd like to view or 
work with Mcmd resources in either ResEdit or Resorcerer rather than 
Constructor, you'll need to add the appropriate template to your resource 
editor so that it can properly display Mcmd resources. Metrowerks has 
included TMPL resources for both of these popular resource editors. 
Without these templates, editing Mcmd resources in either ResEdit or 
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Resorcerer would require that you use the resource editor's hex editor­
definitely not an easy task. With these templates, PowerPlant resources 
such as the Mcmd can be opened in an easy-to-edit format. 

If you use Resorcerer as your resource editor, read the next section. 
If you're a ResEdit user, skip the following section and move on to The 
Mcmd Resource and ResEdit section. 

The Mcmd Resource and Resorcerer 
If you're a Resorcerer user, copy the file named PowerPlant Resorcerer 
TMPLs into the Private Templates folder in your Resorcerer folder (if 
you don't have a Private Templates folder, create a new untitled folder 
and give it this name). Refer to Figure F.l. The PowerPlant Resorcerer 
TMPLs file can be found on this book's CD. If you own the full version 
of Metrowerks CodeWarrior, you'll find it on that CD as well (search 
from the Finder to find out exactly where this file is on the CD). 

s File Edit Resource Window Uiew 

Resorcerer® 1 .2.5 
6 items 293 MB in disk 

~Iii§ PowerPlant Resources §Iii 
6 items 293 MB in disk • Resorcerer® 1.2.5 

Figure F.1 Resorcerer users should make sure the 
PowerPlant Resorcerer TMPLs file is in the Private Templates folder. 

If you'd like to get a little practice working with Mcmd resources in 
Resorcerer, create a new, empty Resorcerer file in a scratch folder. I've 
named mine PPlntro.rsrc, but you can give your file any name you 
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want. The next several pages will describe how to add three Mcmd 
resources to this file. The result will be Mcmd resources for the menus 
shown in Figure F.2. 

!'!'bout PP Intro ... 

mt acol 

Undo 3€2 

Cut 3€H 
Copy ace 
Paste 3€U 
Clear 
Select Rll 3€R 

Figure F.2 The three menus for which Mcmd resources will be created. 

With an open Resorcerer file, select New Resource from the Resource 
menu. Resorcerer's New Resource dialog box, pictured in Figure F.3, 
will open. Scroll to Mcmd and click on it. 

Known types Choose the type (and optional ID 

MACS 
MBAR 
MBDF 
mck:y 
Mcmd 
mctb 
MOH 
mem ! 
MENU 
mhlr 
minf 

t& 
mm 

m~11 
mm ,, 
mm 
=~;n: 

~ {\> 

or name) of the major resource 
you wish to create: 

Type: jMcmd 

ID: j 128 

Name: 

Unique ID 

Attrs: O m 0 ~ 0 iB 0 osi D ~ 

([ Create ]J ( Cancel 

Figure F.3 Resorcerer's New Resource dialog box, with the Mcmd type selected. 
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After clicking the Create button, Resorcerer creates a new Mcmd 
resource, gives it an ID of 128, and opens the Mcmd editor. Initially the 
Mcmd has no items in it. Click the New button to add an item. Figure F.4 
shows that Resorcerer gives new items a value of 0. 

~Iii~ New Mcmd 128 from PPlntro.rsrc ~Iii 

• Number of Commands 1 {} 
Number of Commands • 1 ················ 

~ Command Number cmd...Nothing= 0 

New ) ([ Edit ] ( Cancel ) 

Figure F.4 Adding a new command number to an Mcmd resource. 

You can change the value of the new item to any of the PowerPlant­
defined Mcmd constants-they're listed in the arrow pop-up menu that's 
located to the left of the new item. Figure F.5 shows that the menu item 
is being given the value represented by the constant cmd_About. 

In Figure F.6, you can see that the menu item now has a value of 1. 
Recall from Table 10.1 that cmd_About is a constant that represents the 
number 1. Figure F.7 shows the relationship between a MENU resource, 
an Mcmd resource, and the command number constants. 

The Apple menu for the hypothetical program I'm creating the 
resources for has just this single About item, so the Mcmd resource for 
MENU 128 is complete. You can save the changed resource and click in 
the close box of the Mcmd editor. 

Next, give the Mcmd a descriptive name by selecting Resource Info 
from the Resource menu. Type the name "Apple" in the Name field, as 
shown in Figure F.8. This name will be displayed in Resorcerer, but 
won't be used by the application that uses the resource. Save the file 
and close the Resource Information dialog box. 
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cmd_Saue 
cmd_SaueRs 

• cmd_Reuert 
cmd_PageSetup 
cmd_Print 
cmd_PrintOne 
cmd_Quit 
cmd_Undo 
cmd_Cut 
cmd_Copy 
cmd_Paste 
cmd_Clear 
cmd_SelectRll 
..... 

Figure F.5 Changing the command number of an item in an Mcmd resource. 

• Number of Commands 1 
Number of Commands •1 ........... ..................... ........... . 

e:!:) Command Number cmd_About= 1 

New J n Edit 

Figure F.6 The Mcmd resource with one menu command number. 
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MENU 128 from PPlntro.rsrc 

• ~1------------~11 
181 Menu enabled MDEF: ro=-J 

0 ~ Menu ID: ~ Hbout PPlntro68K ... 

• Number of Commands 1 
Number of Commands • 1 · 

.. Colors ......................................................... , 

[ This Menu J [ Menu Bar ] 

Menu Item 

""--:~V 
!:!'.) Command Number- cmd_About= 1 

Cancel J 

Figure F.7 The Mcmd resource ID matches the ID of a 

MENU resource, and its command numbers correspond to menu items. 

15 Mcmd 128 Info from PPlntro.rsrc 

Type: IMcmd 

Owner: I None ,.. I 
ID: I 12e 

Name: I Hpple 

0 tT Purgeable 
0 ~ Preload 
O fl Locked 

0 ~ Protected 
0 l!I SysHeap 

Size: 6 

I 

[ Cancel J 

([ OK )J 

Figure F.8 Naming the Mcmd resource. 

Now create the Mcmd for the File menu. Click the New button in the File 
window-as is being done in Figure F.9. Resorcerer will create a new 
Mcmd resource with an ID of 129. You can click on the Info button in the 
File window to give this new resource the name "File." 
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-• PP I ntro.rsrc 
Typ@s: 1 'Mcmd' (PowerPlant Menu Commands) Resource : 

<DF> if ···················'·······~· ... i 128 Appl@ 
Momd 

0 

~~~~·=~=====================:;;;;;;;;;;;;; 
Select Rll ] [ Reuerse 

Changed J [ None 

Figure F.9 Adding a new Mcmd resource to a resource file. 

Click the New button to add an item. Like this example's Apple menu, 
the File menu has only one menu item-here it's the Quit item. 
PowerPlant defines cmd_Qui t to have a value of 10, so that's the com­
mand number to enter in the File menu's Mcmd resource. If you didn't 
remember that a Quit menu item should have an Mcmd command num­
ber of 10 (or you didn't care to look it up), simply use the pop-up menu 
to select cmd_Quit, as was done for the About menu item in the Apple 
menu. Figure F.10 shows the Mcmd resource for the File menu. 

Number of Commands 1 
Number of Commands •1 

[!l Command Number cmd_Quit= 1 0 

New } ([ Edit J) 

Figure F.10 The Mcmd resource for the PP/ntro68K File menu. 

Next, create an Mcmd resource for the Edit menu. Again click the New 
button in the File window, as shown back in Figure F.9. Then click the 
New button in the Mcmd editor and use the pop-up menu to add the 
Undo menu command number. Insert each of the Edit menu's seven 
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command numbers in this way. Figure F.11 shows the Mcmd resource 
that is used for the Edit menu. 

§Im§§ Mcmd 130 "Edit~· from PPlntro.rsrc §§Im 

Number of Commands 7 
Number of Commands # 1 

('.!'.) Command Number cmd_JJndo=l 1 
Number of Commands #z · 

('.!'.) Command Number cmd....Nothing=O 
Number of Commands #3 ······· 

('.!'.) Command Number cmd...Cut=l 2 
Number of Commands #4 ············ 

('.!'.)Command Number cmd....Copy=13 
Number of Commands #5 ········· ····························· ···· 

('.!'.) Command Number omd_? aste= 1 4 
Number of Commands #6 

('.!'.) Command Number cmd....Clear= 15 
Number of Commands #7 

('.!'.) Command Number cmd...Se le ct A 11= 1 6 

New J U Edit ]J Cancel J 

Figure F. 11 The Mcmd resource for the PP/ntro68K Edit menu. 

Note that the IDs of the three Mcmd resources match the IDs of the three 
MENU resources. 

The Mcmd Resource and ResEdit 
If you're a Resorcerer user, skip this section since it covers the material 
you just read, from a ResEdit-user point of view. If you use ResEdit, 
launch ResEdit now. Then open the PowerPlant ResEdit TMPLs file 
that's found on this book's CD. If you own the complete version of 
Metrowerks CodeWarrior, you'll notice that this file also appears on 
that CD; either version will work. Next, open the ResEdit Preferences 
file that's found in the Preferences folder in the System Folder of your 
Mac's hard drive. Click once on the TMPL icon in the Power Plant 
ResEdit TMPLs file and select Copy from the Edit menu. Now click on 
the window that displays the resources in the ResEdit Preferences file 
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and then select Paste from the Edit menu, as shown in Figure F.12. 
You've just copied all of the PowerPlant templates to the ResEdit 
Preferences file. 

s File Edit Resource Window Uiew 

ResEdit Preferenc:es 

PREF' 

MENU PAGE 

VIEW 

PREF 

PREF 

The 
qtdck 
brown 

styl 

Figure F.12 ResEdit users should make sure the TMPL resources from the 

PowerP/ant ResEdit file are copied to the ResEdit Preferences file. 

If you'd like to get a little practice working with Mcmd resources in 
ResEdit, create a new, empty ResEdit file in a scratch folder. I've named 
mine PPlntro.rsrc, but you can give your file any name you want. The 
next several pages will describe how to add three Mcmd resources to this 
file. The result will be Mcmd resources for the menus shown in Figure F.13. 

With a ResEdit file open, select Create New Resource from the 
Resource menu. In the Select New Type dialog box (shown in Figure 
F.14), scroll down to the Mcmd resource. Any resource that appears in 
this list has an editor associated with it. Before adding the PowerPlant 
TM PL resources to the ResEdit Preferences file, the Mcmd resource type 
would not have appeared in this list. Now, ResEdit knows about this 
new template and will use it whenever you add a new Mcmd resource to 
any ResEdit file. After clicking on the Mcmd resource in the list, click 
the OK button. 
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l'?tout PPlntro ... 

38Q I 

Undo 382 

Cut 8€H 
Copy ace 
Paste acu 
Clear 
Select Rll 8€R 

Figure F.13 The three menus for which Mcmd resources will be created. 

Select New Type 

(( OK )J 

( Cancel ) 

Figure F.14 ResEdit's Select New Type dialog box, with the Mcmd type selected. 

You'll see that a new Mcmd resource editing window has opened. 
ResEdit has given this resource an ID of 128, as it does with most new 
resources. Since the MENU resource for the Apple menu has an ID of 
128-and because the Mcmd resource is paired by ID with a MENU 
resource-this Mcmd resource should be used to hold the command 
numbers of the Apple menu items. 
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Click once on the row of asterisks, then select Insert New Field(s) 
from the Resource menu. In the edit box that appears, type in the num­
ber 1. Recall from Table 10.1 that the number 1 is always used for the 
About menu item in the Apple menu. Because there's only one item in 
the Apple menu for the hypothetical program I'm creating, the Mcmd 
resource for this menu will have only one command number in it. 
Figure F.15 shows the completed Mcmd 128 resource. Figure F.16 shows 
the relationship between a MENU resource, an Mcmd resource, and the 
command number constants. 

~Ii Mcmd lD = 128 from PPllltro.rsrc 

Number of 
Commands 

1) ***** 
Command 
Number 

2) ***** 

Figure F.15 The Mcmd resource with one menu command number. 

Next, select Get Resource Info from the Resource menu. Give this 
resource the name "Apple" so that you'll be able to quickly identify this 
Mcmd resource from the others that you'll be creating. This name will be 
displayed in ResEdit but won't be used by the application that uses the 
resource. Figure F.17 shows the ResEdit Get Resource Info dialog box. 
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~Iii§ MENUs from PPlntro.rsrc §Im~ 

:.. .... .. ...... ...... .. ................................. ......... ....... : 

128 

~ ~ 
II 
1: 
~J 

ft: 

I li;f; 
\iii 

Iii Mcmd ID 128 from PP I ntro.rsrc 

Humber of 
Commands 

1) ***** 
A. 

Command l 1 i~ 
Humber ~ 

2) ***** 

le crnd~~ut. = : 1 J 
P""i 

.fr 
1t 
11 II 

'{} 
~ 

Figure F.16 The Mcmd resource ID matches the ID of a MENU resource, 

and its command numbers correspond to menu items. 
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Type: Mcmd 

ID: 

Name: 

Owner ID: 

Sub ID: 

Rttributes: 
D System Heap 
D Purgeable 

D Locked 

Size: O 

Owner type 

DRUR 
WDEF 
MDEF 

D Preload 
D Protected D Compressed 

Figure F.17 Naming the Mcmd resource. 

Now create the Mcmd for the File menu. Again select Create New Resource 
from the Resource menu. Use the Get Resource Info dialog box to give the 
Mcmd resource the name "File." If the Mcmd doesn't have an ID of 129 (to 
match the File MENU resource ID), give it that ID now. The File menu for 
this example has just a single menu item-the Quit item. PowerPlant 
defines cmd_Qui t to have a value of 10, so that's the command number to 
enter in the File menu's Mcmd resource, as shown in Figure F.18. Remember 
to click on the row of asterisks and then select Insert New Field(s) from 
the Resource menu to add an edit text box to the Mcmd editor. 

i§liiEl Mcmd "File" ID= 129 from PPlntro.rsrc ~ 

Number of 1 ~ 
Commands 

1) ***** 
Command j 10 I 
Number 

2) ***** 
~ 
~ 
Iii 

Figure F.18 The Mcmd resource for the PP/ntro68K File menu. 
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Finally, select Create New Resource from the Resource menu to add the 
Mcmd resource for the Edit menu. Using the Get Resource Info dialog 
box, give it an ID of 130 (like the Edit MEN U resource has) and the name 
"Edit." Insert the seven command numbers shown below in this 
resource. Figure F.19 shows a part of the Mcmd resource that is used for 
the Edit menu. 

cmd_Undo 
cmd_Nothing 
cmd_Cut 
cmd_Copy 
cmd_Paste 
cmd_Clear 
cmd Se l ectA 11 

11 
0 

12 
13 
14 
15 
16 

Iii Mcmd "Edit" ID = 1 lO from PPlntro.rsrc 

Number of 7 
Commands 

1) ***** 
Command 111 
Number 

2) ***** 
Command lo 
Number 

3) ***** 
Co mmand i 12 
Number 

'I ) ***** 
Command 113 
Number 

.J:..l."""'"' 

I 
I \ii 

Figure F.19 The Mcmd resource for the PP/ntro6BK Edit menu. 

Note that the IDs of the three Mcmd resources match the IDs of the 
three MENU resources. 



Index 
µextension, 21-22 

fl 
AS World, 349-350, 400, 401 
aede resource type, 199 
aedt resource type, 198 
ALRT resource type, 196-197, 498 
ANSI Console PPC project stationery, 62 
ANSI Console 68K project stationery, 62 
Apple Development Tools folder, 15 
Apple Event Description Table, 198 
Apple Event Terminology Extension 

resource, 199 
Apple Universal Interface header files. See 

Universal Interface header files 
applets, 157-181 

adding, to Web pages, 160 
disk space occupied by, 174 
and HTML, 174-178 
and Java interpreters, 160-161 
and Java programming language, 178-

181 
Applet class, 179-180 
import statements, 178-179 
methods, 180-181 

platform independence of, 158-159 
tags for, in Web pages, 157-158 
viewing, with Java Applet Viewer 
application, 169-171 
and Web browsers, 157-158, 176-178 

Applet class (Java), 179-180 
applet projects, 162-174 

creating, 163-164 
files in, 164-168 

classes.zip, 166-168, 174 
TrivialApplet.html, 168, 171 
TrivialApplet.java, 165-166 

folders for, 171-174 

viewing, 169-171 
<applet> tag, 158, 174-176 
applet viewer, 169-171 
applications. See also fat binary applica­

tions; projects 
building, 26 
creating new, 29-30 

name, choosing, 49-50 
running the application, 51-52 

definition of, 7 
and project stationery, 20 

application frameworks, 11-13 
application heap. See heap, application 
application stack, 349-351 
Arrow icon column (project window), 26 
assignment operators, in C, 474 
assignment statements, in C, 469 
attributes, HTML tag, 157 

B 
bitmapped graphics, 492 
blocks, 351-358 

free, 352 
headers of, 351 
nonrelocatable, 357-358 
relocatable, 353-357 
size of, 352 

BNDL resource type, 498 
braces, in C, 467 
branching statements, in C, 475-477 

if-else statement, 475-476 
switch statement, 476-477 

breakpoints, 105, 107 
browser window (MW Debug), 104 
browsers. See Web browsers 
building applications, 26 
bytecode, Java, 159-161 
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c 
C language, 463-478 

assignment statements in, 469 
braces, use of, 467 
comments in, 469-470 
conditional statements in, 471 
control statements in, 475-478 

branching statements, 475-477 
looping statements, 477-478 

data types, 468, 472-473 
character data type, 473 
floating-point data types, 473 
integer data types, 472-473 

declaration statements in, 467-469 
function calls in, 470 
function prototypes in, 470-471 
functions in, 467 
#include directives, 471 
main() function, 467 
operators, 473-475 

assignment operators, 474 
comparison operators, 475 
increment/ decrement operators, 

474 
math operators, 474 

sample program in, 464-472 
and IBM-compatible code, 464-465 
source code, 466-471 

source code files, 47 
structure of typical program written in, 
471-472 
variables in, 468 

C++ language, 479-490 
class variables, defining, 487 
classes, defining, 483-485 
derived classes in, 229 
example project, 481-490 
function overloading in, 240 
and IBM-compatible code, 480-481 
main() function, 487 
member functions, defining, 485-486 
objects, creating, 487-489 
objects, deleting, 490 
objects' member functions, invoking, 

489-490 

projects in, 55-57 
source code files, 47 

call chain, 104 
"cannot convert" message, 74 
casting, 500 
CD-RO Ms 

with CodeWarrior, 2. See also 
CodeWarrior Gold edition 

with this book, 3, 8-9 
central processing unit. See CPU 
cfrg resource, 137-139, 151 
ChangingValues68K program, 108-115 

executing, with MW Debug, 111-115 
executing, without MW Debug, 110-

111 
character data type, in C, 473 
classes 

defining, in C ++, 483-485 
derived, 229 
Java, 168 
packages of, 178-179 
PowerPlant. See under PowerPlant 

.class extension, 17 4-175 
classes.zip, 166-168, 174 
ClickSelf() function (LPane class), 334, 341 

overriding, 338-340 
Code column (project window), 25 
CODE resource type, 150, 151, 385, 387, 

388,498 
fat binary applications, 139, 408-410 
MacDraw Pro, 367-368 
PictMemBad68K, 368-370 
PowerPC applications, 137-138 
68K applications, 136-137 

codebase, 175 
CodeWarrior 

editions of, 3-5 
Academic,4 
Academic Pro, 4 
Discover Programming for 

Macintosh, 3, 4 
Discover Programming with Java, 

4-5 
Gold. See CodeWarrior Gold edition 

Lite version of, 191-192 



as programming package, 1-2 
versions of, 3, 9 

CodeWarrior Gold edition, 2-4 
CD-ROM package, folders included in, 

9-15 
Apple Development Tools folder, 

15 
CoolDemos, SDKs, & Tools folder, 

14-15 
Metrowerks CodeWarrior folder, 

10-11 
Metrowerks PowerPlant folder, 

11-13 
Other Metrowerks Tools folder, 

13-14 
updated versions of, 9 

CodeWarrior IDE, 2, 10-11 
ColeWarrior Plugins folder, 11, 12 
colors, 130-133 
command numbers, 280 

constants, adding command number, 
301-303 

commanders, 256, 262-263 
comments, in C, 469-470 
compaction,memory,353,354 
comparison operators, in C, 475 
Compile column (project window), 25 
Compilers folder, 11 
compiling 

choosing compiler, 46-47 
and running project code, 26-28, 47-48 

conditional directives, 142 
conditional statements, in C, 471 
console projects, 52-54 
console window, 52-54 
ConsoleEx68K application, 52-54 
ConsoleEx68K project, 53 
constants 

defining menu item, in PowerPlant, 
280-281 

naming, in PowerPlant, 226-227 
Constructor, 201-219 

creating panes with, 313-315 
Menu Bar resources, 217-218 
PPob resource type, 207-217 

project windows in, 203 
Txtr resources, 218-219 

Index 

viewing Constructor file resources 
in Constructor, 204-207 
in ResEdit, 203-204 

Constructor Manual, 203 
containment hierarchy, 313 
control statements, in C, 475-478 

branching statements, 475-477 
looping statements, 477-478 

CoolDemos, SDKs, & Tools folder 
(Reference CD-ROM), 14-15 

CPPMenuApp.cp, 297-298, 327, 328 
CPPMenuApp.h, 299, 327, 328 
CPPPaneApp() class (PowerPlant), 335-

336 
CPPPaneApp.cp, 343-345 
CPPPaneApp.h, 343 
CPPStarterApp class (PowerPlant), 229, 

230,235,256-257,268-269,272,273 
CPPStarterApp() function (LApplication 

class), 243 
CPU (central processing unit), 5 

and Java source code, 159 
CreateTestPaneStream() function 

(CTestPane class), 336-337, 340-341 
CreateWindow() function (LWindow 

class), 216, 237 
CTestPane class (PowerPlant), 334-335 
CTestPane.cp, 340-343 
CTestPane.h, 340 
current statement arrow, 105 

D 
Data column (project window), 25 
data fork, 136, 137, 150-152 
data types 

in C, 468, 472-473 
character data type, 473 
floating-point data types, 473 
integer data types, 472-473 

naming, in PowerPlant, 226 
debuggers, 100 
debugging, in PowerPlant, 241. See also 

MW Debug 
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declaration statements, in C, 467-469 
#define directive, 251 
Delay() Toolbox function, 90-96 
DelaySound example application, 90-96 
dereferencing, double, 354 
derived classes, 229 
Dialogs.h header file, 67 
Discover Programming for Macintosh edi­

tion of CodeWarrior, 3, 4 
Discover Programming with Java edition 

of CodeWarrior, 4-5 
DispatchEventO function 

LApplication class, 233-235 
LEventDispatcher class, 233-235 

DITL resource type, 196, 498 
DLOG resource type, 498 
double indirection (double dereferencing), 

354 
DrawCircle() function, 427, 428 
drawing areas, 310 
DrawObjects() function, 440-441 
DrawResourcePicture() function, 362-364, 

395 
DrawSelf() function (LPane class), 334 

overriding, 337-338 
DrawSquare() function, 427, 428 
drawstring() function (Java), 167, 181 
DrawString() Toolbox function, 127-128, 

325 
DrawStuff() function, 426-428 
DRVR resource type, 498 

E 
editions, CodeWarrior, 2-3 
EmptyWindowPPC.E, 31-51 
EmptyWindowPPC.rsrc, 34-35 
emulation mode, 6, 7, 139 
emulator, 6 
errors, and Universal Interface header 

files, 7 4-86 
correction of errors, 84-86, 93-96 
Errors & Warnings window, 78-81 
function prototype, finding, 82-83 
incompatible code, 74-75 
opening header file, 81-82 

parameter data types, comparing, 83-
84 

in PlaySound project, 75-86 
Errors & Warnings window, 48, 72, 74, 78-

81, 148 
event-driven programming, 492-493 
EventLoop68K example program, 450-452 
Events.h header file, 67 
executable code 

in fat applications, 138-139 
in PowerPC applications, 137-138 
in 68K applications, 136-137 

extends keyword (Java), 180 
extensions, files, 46-47 

F 
fat binary applications, 135-153 

building, 139-152 
and Errors & Warnings window, 

148 
resource editor, examining program 

with, 149-152 
second PowerPC projects, creating, 

145-147 
single source code file, using, 142-

144 
68K and PowerPC projects, creating, 

140-142 
creating, 30 
definition of, 6-7 
executable code in, 138-139 
PowerPC applications vs., 137-138 
and RAM, 408-410 
68K applications vs., 136-137 

fgColor field (Grafport data type), 130-
133 

File column (project window), 25 
file search sets, 87-96 

correcting errors with, 93-96 
creating, 87 
definition of, 88 
naming, 89, 90 
saving, 88, 89 

Find dialog box, 87-88, 93-94 
FindCommandStatus() function 



(LApplication class), 227-228, 244-245, 
269 
adding, 305-306 
overriding, 277-279 
writing, 283 

floating-point data types, in C, 473 
forks, 136-138, 150-152 
FrameRect() Toolbox routine, 325 
free blocks, 352 
"function call does not match prototype" 

message, 91, 92 
function calls, in C, 470 
function overloading, 240 
function parameters, naming, in 

PowerPlant, 227-228 

G 
Generate SYM info column (project win­

dow), 26 
GetNewWindow() Toolbox function, 57, 

62-64, 66, 122 
GetPictureO Toolbox routine, 353, 393 
GIF files, 157 
Gold edition. See CodeWarrior Gold edition 
GrafFort data type, 122-133 

changing fields values in, 126-130 
fgColor field in, 130-133 
fields in, 122-125 
pnLoc field in, 127, 128 

Graphics class (Java), 181 
groups, 23-25, 415-416 

collapsing and expanding, 24 
namesof,23 

GUI, and resources, 498 

H 
handles, 354 
headers 

block, 351 
zone,374 

header files. See also Universal Interface 
header files 

heap, application, 349-352, 364-373 
estimating requirements for, 365-371 

initializing, 241-242 
size of, 364-365 

changing, 372-373 
minimum heap size, 365 
preferred heap size, 365 

Inda 

viewing, with ZoneRanger, 383-392 
after picture display, 389-392 
before picture display, 383-388 

heap zone, 374 
Heap Zones window (ZoneRanger), 374-

375 
Hide() function (LPane class), 333 
HideWindow() Toolbox function, 110, 

112, 114 
Histogram window (ZoneRanger), 377-

379 
HTML (Hypertext Markup Language) 

and applets, 174-178 
tags, 157 
and Web browsers, 156-157 

Hypertext Markup Language. See HTML 

I 
ICN# resource type, 498 
IDE (integrated development environ­

ment), 2 
#ifdef conditional directive, 142-144 
import statements (Java programming 

language), 178-179 
#include directive, 62-64, 343 

and MacHeaders header file, 67 
increment/decrement operators, in C, 474 
indirection, double, 354 
InitializeToolboxO function, 225, 237-240, 

427 
Int8 data type, 226 
Int16 data type, 226 
Int32 data type, 226 
integer data types, in C, 472-473 
integrated development environment 

(IDE), 2 
Internet Explorer, 157 
Internet Service Providers (ISPs), 157 
ISPs (Internet Service Providers), 157 
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J 
Java, 155-157, 178-181. Seealsoapplets 

Applet class, 179-180 
applications written in, 161-162 
import statements, 178-179 
methods, 180-181 
platform independence of, 159 

Java interpreters, 160-161 
and Java applications, 161-162 
and Web browsers, 161 

JavaClasses folder, 172 
JPEG files, 157 

K 
keywords,468 

L 
LApplication class (PowerPlant), 228-236, 

242-245, 263 
application objects, creating, 230 
CPPStarterAppO function, 243 
derived classes, creating, 229 
DispatchEvent() function, 233-235 
and event handling, 228-229 
FindCommandStatus() function, 244-

245, 283, 305-306 
importance of, 235 
ObeyCommand() function, 244-245, 

256-257, 264-276, 281-283, 303-305 
purpose of, 228-229 
RegisterAllPPClasses() function, 243 
Run()function, 231-233, 235, 236 
StartUp() function, 243-244 

LApplication.cp, 231 
layout editor, 208-210, 212-215 
LCaption class (PowerPlant), 215, 312 
LCommander class (PowerPlant), 276 
LEditField class (PowerPlant), 263 
LEventDispatcher class (PowerPlant), 235 
LGrowZone object, 242 
LMenu class (PowerPlant), 252 
locals pane (stack crawl window), 104 
locked/unlocked attribute, 353 
looping statements, in C, 477-478 

LPane class (PowerPlant), 310-313, 333-
335 

LPicture class (PowerPlant), 312, 323 
LScroller class (PowerPlant), 312-313 323 
LView class, 310-313 ' 
LWindow class (PowerPlant), 216, 236-

237, 263, 320, 321, 323, 344-345 
LWindow.h, 236 

M 
MacHeaders68K precompiled header file, 

65,92 
MacHeaders.h precompiled header file, 

65-66, 73-7 4 
and #include directive, 67 

MacHeadersPPC++ precompiled header 
file, 65 

l\1acintoshprogramming,491-495 
and bitmapped graphics, 492 
and event-driven programming, 492-

493 
resources in, 493-494 
Toolbox routines, 494-495 

main() function, 467, 487 
master pointer, 354-356 
math operators, in C, 474 
MBAR resource type, 249-250 

editing, 288 
Mcmd resource type, 204-208, 252-253, 

507-520 
with ResEdit, 514-520 
with Resourcer, 508-514 

memberfunctions,484-486,489-490 
memory, l\1acintosh, 348-359 

blocks, 351-358 
free, 352 
headers, 351 
nonrelocatable, 357-358 
relocatable, 353-357 
size of, 352 

heap, application, 351-352, 364-373 
estimating requirements for, 365-

371 
size of, 364-365, 372-373 

partitions, application, 349-351 



memory compaction, 353, 354 
Memory Manager, 117, 355, 357 
menus, and PowerPlant, 186, 247-307 

application-specific items, adding, 
279-283 
command numbers, 280 
constants, defining menu item, 

280-281 
FindCommandStatusO function, 

writing, 283 
MENU resources, 280 
ObeyCommand() function, writing, 

281-283 
commanders, 262-263 
commands,256-263 
PowerPlantMenu68K example applica-

tion, 284-306 
project, creating, 285 
resources, 285-294 
running,306 
source code, 294-306 

resources, menu, 248-256 
items, menu, 251-255 
MBAR resource, 249-250 
Mcmd resource, 252-253 
MENU resource, 249 
PowerPlantlntro68K program, 248-

249 
selections, handling, 263-279 

FindCommandStatus() function, 
overriding, 277-279 

ObeyCommand() function, 264-276 
target objects, 262-263 

Menu Bar resources (Constructor), 217-218 
MENU resource type, 204, 206-208, 249, 

280 
MenuSelect() Toolbox routine, 251 
methods, in Java programming language, 

180-181 
Metrowerks CodeWarrior folder (Tools 

CD-ROM), 10-11,22 
Metrowerks Java, 169-171 
Metrowerks PowerPlant folder (Tools 

CD-ROM), 11-13 
Metrowerks Profiler, 14 

Index 

Metrowerks World Wide Web site, 3 
microprocessors, 5, 348 
MoveTo() Toolbox function, 127-128 
Muscle Demo example program, 321-325 
MW Debug, 99-133 

changes in variable values, observing, 
116-120 

and data structures, 120-133 
GrafPort data type, 122-133 
Rect data type, 120-121 
WindowPtr data type, 122, 126 
WindowRecord data type, 122 

enabling, 101-102 
with example program, 108-115 

executing, with MW Debug, 111-115 
executing, without MW Debug, 

110-111 
installing, 100-101 
program execution, controlling, 106-

108 
stopping, 106-106 
windows in, 102-105 

browser window, 104 
stack crawl window, 104-105 

ZoneRanger vs., 397-399 
MyFirstC++Program.µ, 480-490 
MyFirstCProgram.µ, 465-472 
MyFirstJavaApplet folder, 171 
MyFirstMacApp.µ, 21-29 

" naming 
applications, 49-50 
PowerPlant conventions for, 224-228 

classes, 225 
constants, 226-227 
data types, 226 
function parameters, 227-228 
variables, 226 

projects, 21-22 
native code, 5 
native mode, 8 
Netscape Navigator 3.0, 157, 161, 177-178 
New Project dialog box, 19, 21, 30-32 
NewWindowO Toolbox function, 57, 108-
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110, 113, 118, 122 
nonrelocatable blocks, 357-358 

0 
ObeyCommand() function (LApplication 

class), 244-245, 256-257, 264-276 
adding, 303-305 
and chain of command, 264-267 
overriding, 267-271 
writing, 281-283 

objects, in C ++ 
creating, 487-489 
deleting, 490 

ObjectEx68K application, 55-57 
ObjectEx68K project, 55, 57 
lD Graphical window (ZoneRanger), 382-

383 
OpenDrawWindowO function, 426, 435-

440 
operators, in C, 473-475 

assignment operators, 474 
comparison operators, 475 
increment/ decrement operators, 47 4 
math operators, 474 

optimization, 14 
OSUtils.h header file, 95 
Other Metrowerks Tools folder (Tools 

CD-ROM), 13-14 

p 
packages, 178-179 
paint() method, 180-181 
panes, 209-217, 309-345 

creating, with Constructor, 313-315 
definition of, 207, 310 
IDs of, 209-210 
and layout editor, 212-215 
and PowerPlant classes, 215-217 
and property inspectors, 210-212 
resizing, 213-214 
subpanes, 313 
superviews of, 313 
and views, 310-313 

partitions, application, 349-351 

Pascal compilers, 46 
PICT resource type, 360, 370, 371, 389, 

393-396,398,442-450,498 
PictMemBad68K example program, 359-

364 
examining memory usage by, 393-399 

memory problem, correcting, 394-
397 

memory problem, discovering, 392-
394 

MW Debug as alternative, 397-399 
viewing heap, after picture display, 

388-392 
viewing heap, before picture dis­

play, 383-388 
resource types, 360-361 
source code, 361-364 

PictMemBad68K.c, 361-364 
PictureResource68K example program, 

443-450 
platform independence, 158 
PlaySound project, 75-86 
PlaySound68K folder, 140 
PlaySound68K.µ project, 141 
PlaySoundFat folder, 141 
PlaySoundFat.µ project, 145-147 
plugins, 46 
pnLoc field (GraiPort data type), 127, 128 
PowerPC chip, 5, 47 
PowerPC-based (PPC-based) Macintosh 

computers, 5-8 
PowerPlant, 183-219 

about, 185-188 
classes in, 190-192, 215-217, 221-224, 

228-240 
header file, 222-224 
LApplication class, 228-236, 242-245 
LEventDispatcher class, 235 
LMenu class, 252 
LWindow class, 236-237 
naming conventions, 225 
source code file, 223, 224 
and static member functions, 237-

238 
and Toolbox routines, 238-240 



UQDGlobals class, 225, 237-241 
utility classes, 225, 237 

commands in, 256 
and Constructor resource editor, 201-

219 
Constructor, viewing Constructor 

file resources in, 204-207 
Menu Bar resources, 217-218 
PPob resource type, 207-217 
ResEdit, viewing Constructor file 

resourcesin,203-204 
Txtr resources, 218-219 

creating applications using, 188-189 
debugging, enabling, 241 
default program, running, 192-193 
installing, 187-188 
main() function, 240-242 
and menus, 186, 247-307 

application-specific items, adding, 
279-283 

commanders, 262-263 
commands, 256-263 
menu resources, 248-256 
PowerPlantMenu68K example 

application, 284-306 
selections, handling, 263-279 
target objects, 262-263 

naming conventions, 224-228 
classes, 225 
constants, 226-227 
data types, 226 
function parameters, 227-228 
projects, 189 
variables, 226 

and panes, 309-345 
creating, with Constructor, 313-315 
drawing areas, 310 
Muscle Demo program, 321-325 
PowerPlantPane68K example 

program,319-321,325-345 
PPob resource, creating, 315-318 
scrollers, 312-313 
subpanes, 313 
superviews, 313 
top level containers, 313 

views, 310-313 
project stationeries with, 20 
resource files, 194-201 

Index 

PP Action Strings.rsrc, 199-200 
PP Basic Resource.ppob, 201 
PP Basic Resource.rsrc, 195-199 
PP DebugAlerts.rsrc, 200-201 

PowerPlantlntro68K.µ, 190-192, 202, 224, 
225 

PowerPlantlntro68K program, 248-249 
PowerPlantMenu68K.µ, 285-286 
PowerPlantMenu68K example applica-

tion, 284-306 
project, creating, 285 
resources, 285-294 

MBAR resource, editing, 288 
new menu items, adding command 

numbers to, 291-294 
new menu resource, adding items 

to, 290-291 
new menu resource, editing, 288-

290 
PPob resource, editing, 286-287 

running,306 
source code, 294-306 

command number constants, 
adding, 301-303 

FindCommandStatus() function, 
adding to, 305-306 

header file, editing, 296-297 
header file, renaming, 294-296 
ObeyCommand() function, adding 

to, 303-305 
source code file, editing, 299-301 
source code file, renaming, 297-298 

PowerPlantPane68K.µ, 328, 329 
PowerPlantPane68K example program, 

319-321, 325-345 
classes in, 328, 333-335 
project, setting up, 327-328 
resources in, 329-333 

Menu resources, 332-333 
PPob resource, 329-332 

source code, 333-345 
ClickSelf() function, overriding, 
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338-340 
CPPPaneApp.cp source code file, 

343-345 
CPPPaneApp.h header file, 343 
CTestPane.cp source code file, 

340-343 
CTestPane.h header file, 340 
DrawSelf() function, 337-338 
LPane class, 333-335 
RegisterClass() function, 335-337 

PP Basic Resource.ppob, 202-205, 213, 
250,286,288,314,315,319,332-333 

PP Basic Resource.rsrc 
aede resource type, 199 
aedt resource type, 198 
ALRT resource type, 196-197 
DITL resource type, 196 
STR# resource type, 197-198 

PP Basic Starter.cp, 185, 186, 223-224, 229, 
230, 238, 294, 297-298 
source code, 240-242 

PP Basic Starter.h, 185, 229, 230, 232, 240, 
268, 294-296, 299 

PPob resource type, 207-217, 329-332 
creating, with Contructor, 315-318 
editing, 286-287 
layout editor, 208-210, 212-215 
and PowerPlant classes, 215-217 
property inspectors, 210-212 

precompiled header files, 64-67 
printf() function, 54 
Process Manager, 138-139 
processes, 349 
ProcessN extEvent() function 

(LApplication class), 233 
Profiler, 413-460 

adding code libraries from, to projects, 
415-420 
Profiler calls, generating, 418-420 
selecting library, for 68K project, 

416-418 
selecting library, for PowerPC 

project, 418 

with event-driven Mac applications, 
450-460 
EventLoop68K program, using, 450-

452 
and function dependencies, 452-454 
outpu~examining,454-460 

example,425-434 
output file, 429-434 
source code, 426-428 

functions, 420-423 
PICT resources, analyzing drawing 

time of, 442-450 
output, examining, 448-450 
test program, creating, 442-448 

speeding up functions with, 434-441 
OpenDrawWindow() function, 

437-440 
sampling of execution time, obtain­

ing, 435-437 
slow part of function, determining, 

440-441 
ProfilerDump() function, 423 
Profiler.h, 420 
Profilerlnit() function, 420-424 
Profilerlntro68K.µ, 425-434 

output file, 429-434 
source code, 426-428 

ProfilerTerm() function, 423 
programs. See applications 
programming, Macintosh. See Macintosh 

programming 
projects, 17-57. See also applications 

adding profiling to, 415-420 
PowerPC project, selecting library 

for, 418 
Profiler calls, generating, 418-420 
68K project, selecting library for, 

416-418 
applet, 162-174 

creating, 163-164 
files in, 164-168 
folders for, 171-174 
viewing, 169-171 

C++, 55-57 



compiling 
choosing compiler, 46-47 
running the code, 26-28, 47-48 

console, 52-54 
creating new, 18-26, 30-32 

name, choosing, 21-22 
project stationery, choosing, 19-21 
project window, using, 23-26 

definition of, 7, 18 
fat, 8 
PowerPC-only, 8, 31-32 

selecting Profiler library for, 418 
resource file, adding, 29, 32-42 

creating resource file, 34-38 
removing placeholder, 41-42 
resource editor, launching, 32-34 

68K,7 
selecting Profiler library for, 416-418 

source code file, adding, 29, 42-46 
creating source code file, 42-44 
removing placeholder, 45-46 

Project menu, 101-102 
Project Settings dialog box, 47, 49-50 
project stationery, choosing, 19-21 
(Project Stationery) folder, 11 
project windows, 23-26 

areas in, 23 
Arrow icon column in, 26 
Code column in, 25 
Compile column in, 25 
in Constructor, 203 
Data column in, 25 
File column in, 25 
Generate SYM info column in, 26 
groups in, 23-25 

property inspectors, 210-212 
purgeable/unpurgeable attribute, 353 

Q 
Quic:kDraw.h header file, 67, 130-131 

R 
RAM, fat binary applications and, 408-410 
ReadCommandNumber() function 

(LMenu class), 252 

Inda 

Rect data type, 120-121 
RedIDT data type, 226 
RegisterAllPPClasses() function 

(LApplication class), 243 
RegisterClass() function (PowerPlant), 

335-337 
ReleaseResource() function, 395-396 
relocatable blocks, 353-357 

and handles, 354 
keeping track of, 355-357 
locked/unlocked attribute of, 353 
purgeable/unpurgeable attribute of, 

353 
resource data/nonresource data 

attribute of, 353 
ResEdit, 15 

creating resource file with, 35-36 
examining applications with, 149-152 
launching, 33 
Mcmd resource type with, 514-520 
Resourcer as alternative to, 503-506 
viewing Constructor file resources in, 

203-204 
ResizeFrame() function (LPane class), 333 
resources, 493-494, 497-501 

andGUI,498 
and source code, 499-501 

resource data/nonresource data attribute, 
353 

resource editor, 493. See also Constructor; 
ResEdit; Resourcer 

resource files 
adding, to projects, 29, 32-42 

creating resource file, 34-38 
removing placeholder, 41-42 
resource editor, launching, 32-34 

duplicate, with fat applications, 148-
149 

resource fork, 136, 138, 151 
resource types 

aede,199 
aedt, 198 
ALRT, 196-197, 498 
BNDL,498 
drg, 137-139, 151 
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CODE, 136-139, 150, 151, 498 
DITL, 196, 498 
DLOG,498 
DRVR,498 
ICN#,498 
MBAR, 249-250, 288 
Mcntd,204-208,252-253 
MENlJ,204,206-208,249,280 
PICT,360,370,371,389,393-396,398,498 
PPob. See PPob resource type 
SIZE, 372, 498 
Snd,498 
snd, 76-77, 148 
STR#, 197-198, 200, 498 
l-VIND,207,216,370,385-387,498 

Resourcer, 14-15 
as alternative to ResEdit, 503-506 
creating resource file with, 36-38 
launching, 33-34 
Mcmd resource type with, 508-514 

Resources.h header file, 67 
Run() function (LApplication class), 231-

233, 235, 236 

s 
scan£() function, 54 
search sets. See file search sets 
searching Universal Interface header files, 

86-96 
DelaySound example program, 90-96 
file search sets, using, 87-96 
Find dialog box, using, 87-88 

segments, 24 
SetDebutSignal_O macro, 241 
SetDebutThrow_O macro, 241 
SetRect() Toolbox function, 121 
SetVolume project, 68-70 
Show() function 

LPane class, 333 
LWindow class, 216, 237, 345 

ShowWindow() Toolbox function, 110, 
112, 217 

SillyBalls.c, 29, 32 
SillyBalls.rsrc, 29, 32-35, 41 
SIOUX libraries, 52 

680x0 based Macintosh computers, 5-8 
680x0 emulator, 6 
68K applications, 6, 18 
SIZE resource type, 372, 498 
snd resource type, 76-77, 148, 498 
SndChannelPtr data type, 84 
SndListHandle data type, 84, 85 
SndPlay() Toolbox function, 80-86 
Sound.h header file, 67, 81-83, 85, 92 
source code/source code files 

adding, to project, 29, 42-46 
creating source code file, 42-44 
removing placeholder, 45-46 

MyFirstC++Program.p, 481-490 
MyFirstCProgram.p, 466-471 
PictMemBad68K.c, 361-364 
PowerPlant, 223, 224, 297-303, 333-345 

ClickSelf() function, overriding, 
338-340 

command number constants, 
adding, 301-303 

CPPPaneApp.cp source code file, 
343-345 

CPPPaneApp.h header file, 343 
CTestPane.cp source code file, 

340-343 
CTestPane.h header file, 340 
DrawSelf() function, 337-338 
editing file, 299-301 
LPane class, 333-335 
RegisterClass() function, 335-337 
renaming file, 297-298 

Profilerlntro68K.p, 426-428 
and resources, 499-501 

source pane (stack crawl window), 105 
SpeakPhrase example application, 68-74 

omitting header files and libraries, 
effect of, 71-74 
SetVolume project, 68-70 
source code file, 69-71 

Speech Manager extension (System 
folder), 68 

Speech.h header file, 67, 71-72 
stack, application, 349-351 
stack crawl window (MW Debug), 104-105 



locals pane of, 104 
source pane of, 105 
stack pane of, 104 

stack pane (stack crawl window), 104 
StartUp() function (LApplication class), 

243-244 
step control buttons, 107-108 
STR# resource type, 197-198, 200, 498 
subpanes, 313 
Summary window (ZoneRanger), 375-377 
Sun Microsystems, 178 
superviews, 313 
SYM files, 26, 28, 51, 104 
synthetic menu commands, 275-276 
System file, 62 

T 
tags, HTML, 157 
target objects (PowerPlant), 262-263 
Text Trait resources (Constructor), 218-219 
ticks, 95 
timebases, 421 
timing, program. See Profiler 
Toolbox, 59-60 
Toolbox functions, 494-495 

Delay(), 90-96 
Drawstring(), 127-128, 325 
FrameRect(), 325 
function prototypes for, 60-62 
GetNewWindow(), 57, 62-64, 66, 122 
GetPicture(), 353, 393 
HideWindow(), 110, 112, 114 
including, with #include directive, 62-

64 
MenuSelect(), 251 
MoveTo(), 127-128 
NewWindow(), 57, 108-110, 113, 118, 

122 
and PowerPlant, 238-240 
SetRectO, 121 
ShowWindow(), 110, 112, 217 
SndPlay(), 80-86 
in System file, 62 
WaitNextEvent(), 233 

toupper() function, 54 

Index 

trailers, zone, 374 
TrivialApplet.html, 168, 171, 174-177 
TrivialApplet.java, 165-166, 178 
2D Graphical window (ZoneRanger), 379-

382 
Txtr resource, 218-219 

0 
Universal Interface header files, 59-96 

Dialogs.h, 67 
and errors, 74-86 

correction of errors, 84-86, 93-96 
Errors & Warnings window, 78-81 
function prototype, finding, 82-83 
incompatible code, 74-75 
opening header file, 81-82 
parameter data types, comparing, 

83-84 
in PlaySound project, 75-86 

Events.h, 67 
including 

with #include directive, 62-64 
with precompiled header file, 64-67 

and MacHeaders header file, 67 
opening, 81-82 
OSUtils.h, 95 
QuickDraw.h, 67, 130-131 
Resources.h, 67 
searching, 86-96 

DelaySound example program, 90-
96 

file search sets, using, 87-96 
Find dialog box, using, 87-88 

Sound.h, 67, 81-83, 85, 92 
in SpeakPhrase example program, 68-

74 
omitting header files, 71-74 
SetVolume project, 68-70 
source code file, 70-71 

Speech.h, 67, 71-72 
and Toolbox routines, 60-67 
updates of, 61-62 
Windows.h, 62-64, 66, 67 

UpdateMenus() routine (PowerPlant), 
277-278 
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UQDGlobals class (PowerPlant), 225, 
237-241 

utility classes (PowerPlant), 225 
static, 237 

v 
variables 

inC,468 
inC++,487 
naming, in PowerPlant, 226 
obtaining changing values of, 116-120 

versions, CodeWarrior, 3, 9 
views, 310-313 
virtual memory, with native PowerPC 

applications, 405-408 

w 
WaitNextEventO Toolbox function, 233 
Web browsers, 156-158 

and applets, 157-158, 176-178 
and HTML, 156-157 
and Java interpreters, 161 
Java-capable, 157 

Web pages 
adding applets to, 160 
and platform independence, 158 

Web sites, 156-157 
for Metrowerks products, 3 

Webmasters, 158 
WIND resource type, 35-39, 207, 216, 360, 

370, 385-387, 498 
windows 

panes. See panes 
project. See project windows 

WindowPtr data type, 122, 126, 216-217 
WindowRecord data type, 122 
Windows.h, 67 
Windows.h header file, 62-64, 66 
Writelnfo() function, 264-267 

z 
zone header, 374 
zone trailer, 374 
ZoneRanger, 14, 347-348, 373-410 

Heap Zones window in, 374-375 
Histogram window in, 377-379 
MW Debug vs., 397-399 
and native PowerPC applications, 400-

408 
and fat binary applications, 408-410 
memory,400-405 
virtualmemory,405-408 

lD Graphical window in, 382-383 
with PictMemBad68K, 383-399 

memory problem, correcting, 394-
397 

memory problem, discovering, 392-
394 

MW Debug as alternative, 397-399 
viewing heap, after picture display, 

388-392 
viewing heap, before picture dis­

play, 383-388 
Summary window in, 375-377 
2D Graphical window in, 379-382 





Warranty & Support 

METROWERKS AND METROWERKS' LICENSOR(S), AND THEIR 
DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS (COLLECTIVELY 
METROWERKS) MAKE NO WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR­
POSE, REGARDING THE SOFTWARE. METROWERKS DOES NOT 
WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE OF THE 
SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIA­
BILITY, CURRENTNESS OR OTHERWISE. THE ENTIRE RISK AS TO 
THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS 
ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES 
IS NOT PERMITTED BY SOME JURISDICTIONS. THE ABOVE 
EXCLUSION MAY NOT APPLY TO YOU. 

IN NO EVENT WILL METROWERKS AND METROWERKS' LICEN­
SOR(S), AND THEIR DIRECTORS, OFFICERS, EMPLOYEES OR 
AGENTS (COLLECTIVELY METROWERKS) BE LIABLE TO YOU FOR 
ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES 
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSI­
NESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND 
THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE 
SOFTWARE EVEN IF METROWERKS HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME JURISDIC­
TIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. 

Free technical support from Metrowerks is provided by acquiring any 
of Metrowerks' commercial products. You can upgrade from this limit­
ed version of Code Warrior to a commercial product and thereby benefit 
from this technical support. For more information, contact Metrowerks 
at 1-800-377-5416, or via email at sales@metrowerks.com. 



About Thcz CD 
The CD that accompanies this book contains a limited version of the 
Code Warrior integrated development environment (IDE). "Limited" 
means that while this version of Code Warrior can be used to work with 
any of the more than twenty example projects that are also on the CD, 
you won't be able to create new projects of your own. To get the full­
featured version of CodeWarrior-as well as numerous programming 
tools, extensive documentation, and technical support-you'll want to 
purchase the complete Metrowerks CodeWarrior Gold package. Until 
then, you can use this version to compile and modify the supplied 
examples, experiment with different compiler features, and learn more 
about Macintosh programming. 

The CodeWarrior Lite IDE on this CD run on either a 68K Mac (a 
Macintosh driven by either a Motorola 68020, 68030, or 68040 processor) 
or any Macintosh that has a PowerPC processor. So it doesn't matter 
what kind of Mac you have-as long as you have several megabytes of 
free RAM and System 7.1.2 or later installed. 

Once you've popped the CD into your CD-ROM drive, read Chapter 
1 of this book to get an idea of what the many programs and files on the 
CD are for. Then move on to Chapter 2 to see how to write a Macintosh 
program using CodeWarrior! 
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